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WHAT IS THE PURPOSE OF THIS GUIDE? 
Like its title suggests, this guide gives you step-by-step 
instructions on how to use Microsoft’s PowerPoint to create 
mouse-operated talking books using pictures scanned in from 
real books. It will also look at accessing these talking books using 
a single switch. 

 
It is, however, now possible to create your own books on the computer using hardware and software that 
is generally available in schools and many homes. These ‘talking books’ can be tailor-made to the 
interests and abilities of the pupils, text can be symbol-supported, and sounds and speech can be 
included to enable access to those with reading difficulties. 
 
Children can actively help to make their own accessible talking books, and this opens up more 
possibilities of creative and imaginative writing for pupils with learning difficulties. 
 
Before you start... 
Before you start gathering together piles of books to convert, be aware that putting together even a single 
talking book will take time. Creating a template (a master page that contains the page format and the 
buttons for turning the pages) at the outset will save hours of time when making a number of books, but 
even if you only intend to make one, do create a template first. We have created one for you – so that you 
can focus on adding pictures, text and sound today. 
 
First, plan your interactive stories on paper. A storyboard (that is, sketches of each page or slide) will help 
you keep track of the many possible scenes in your story. Make sure you write down titles for each page 
because you'll use those titles when creating the presentation in PowerPoint. On your storyboard, draw 
lines between slides—almost like a path—to show the choices the reader can make in following the story.  
 

CREATE A FOLDER FOR YOUR TALKING BOOK 
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Each completed PowerPoint talking book file stores all its resources (ie pictures and sounds) within itself. 
We strongly recommend that you keep all of your separate picture and sound files, along with the talking 
book file itself, together in one folder. Create a new folder on the Windows desktop. Name it Story Book. 
 

CREATE THE BLANK PAGES FOR YOUR BOOK 
Open PowerPoint. Constructing a talking book is easier if you begin by setting 
up the PowerPoint screen to show all the tools that you will need. Click on the 
View menu and then on Toolbars. You will need at least the Drawing and the 
Picture toolbars, so click on them. The Standard and the Formatting toolbars 
can also be useful. Click on Close. 
 
 
 
 

CREATING A TEMPLATE FOR YOUR PAGES- 

WE HAVE ALREADY DONE THIS FOR YOU! GO TO THE NEXT SECTION! 
Create a blank page.  
 
In the New Slide box, choose blank slide to design the layout of the first slide. 
 
Add the page turning arrows 
To add a forward page turning arrow to the blank page, select the SlideShow menu 
and click on Action Buttons; click on the forward arrow. Position this cross with the 
mouse at the bottom right hand corner of the page and click the mouse. The forward 
arrow button will appear where the cross was positioned and the Action Settings box will  
appear. Click on OK. DO NOT SAVE. 
 
You can adjust the size and position of the arrow button using the mouse. 
Clicking and dragging the small yellow square alters the size of the bevel. 
 
Add the back arrow button in a similar manner by choosing Action 
Buttons from the Slide Show menu and selecting a backwards arrow. 
Place it on the left side of the screen. 
 
Adding a page turning effect 
You can make the next page slide in from the top by clicking on Slide 
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Show and clicking on Slide Transition then choose a transition effect from the drop-down list (eg Uncover 
Left). Select the speed of the transition (Medium) and click on Apply to All Slides. 
 
Don’t add the speaker button yet. The speaker/sound control button is best set up on each page as you 
create your talking book. It is better not to create it in the template file. You now have a slide that can be 
made into a template file for each page of your talking book. 
 
Save the slide as a template. Click on File in the top menu bar, then Save As, and choose Design 
Template in the dialogue box at the bottom. Click in the Filename box and 
type in a name, eg ‘talking story’. Click Save.  
 
The template, will now be available from the New Presentation menu 
whenever you start PowerPoint. You can use this template to create your 
talking book. 
       
          The Story Book template 

CREATING BLANK PAGES FROM THE TEMPLATE 

We will now begin to create a talking book using a template. With PowerPoint already open, 
click on File, then New and the New Presentation window will appear. Select From Design Template and 
locate the Story Book template in the Make A Book folder on the desktop.  
 

PowerPoint has a number of control icons at the bottom of the screen that allow different 
views of all the slides. We will use the Slide Sorter View and Normal or Slide View to show 

all the slides (or pages) in your talking book as you create them.  
 
To create the correct number of blank pages required for your 
book, click on the slide sorter icon, and highlight the blank slide 
by clicking on it once. Then press CTRL and D (duplicate) 
together as many times as you want blank pages for your book. 
It is easy to add or delete pages at any time. These slides will 
automatically be linked to each other by the forwards and 
backwards arrows on the blank pages. 
 

  Create 10 pages for your book.  
Then save as with a new title of your choosing. It will be saved as a PowerPoint presentation. 
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ADDING PICTURES TO YOUR PAGES 
There are a number of sources for your pictures. You can scan them from a book using a desktop 
scanner, use digital camera photographs, or use clipart and graphics from the computer. 
• Adding pictures by scanning from a book. You will need to already have a scanner attached to your 

computer and set up with its own software. 
• Using digital camera picture. Digital camera pictures can be incorporated into talking books. After 

downloading your pictures onto the computer using your camera’s software, they can be treated the 
same as any other computer graphic. 

• Using clipart or pictures from the computer. You will probably find a large number of pictures already 
installed on your computer (Microsoft Office, for example, comes with a good number of clipart 
pictures) and you can get many more pictures and graphics (of varying quality) on websites. All can 
also be incorporated into your talking books.  

 
The Internet can also be a source of picture files  

• Google Image Search: http://images.google.com 
• Yahoo Images: http://dir.yahoo.com/Computers_and_Internet/Graphics/Clip_Art/  
• Microsoft Design Graphics: http://dgl.microsoft.com/ 
• Pcs4Learning: http://pics4learning.com 
•  Enchanted Learning- Picture Dictionary http://www.enchantedlearning.com/Aisfor.shtml  

 

 TODAY WE HAVE PLACED PICTURES FOR YOUR USE IN A FOLDER IN THE MAKE A 
BOOK  FOLDER NAMED PICTURES.  
 
It may be easier to locate your pictures and place them in a Picture Folder within your 
desktop Make A Book folder.  To save a picture from the web, point on an image and 
click the right mouse button to see the menu. Select Save this Image As... from the 
pop-up menu into your pictures folder.  
 
To insert graphics into your PowerPoint Story, go to the Insert  menu, click Picture, and 
choose either Clipart (if you’re using clipart that’s built into Microsoft office software) or 
From File (if you’re using picture files from your Picture folder). 
 

ADDING TEXT TO YOUR PAGES 
To write text onto your pages, first click on the text box icon which will be in the drawing 
menu bar at the top or bottom of the screen, or choose Text Box from the Insert menu. You can change 
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the size and the font of your text in the normal way and you can position your text box anywhere on a 
page by clicking and dragging the edges of the box with the mouse. You can also change the design of 
the page to automatically include a text box; there are several layouts to pick from.  From the Format 
menu, select Slide Layout for choices. 
 
Create a title for your book for the first page; there is a Title Slide layout for this. 
You may want to use the Title only layout or one that includes title, text and objects for the other pages of 
your book. 
 

ADDING SPEECH AND SOUNDS TO YOUR PAGES 
You can record speech to add to your talking book using a microphone plugged into the computer’s 
soundcard (all multimedia computers will have a soundcard). Plug the microphone into the microphone 
socket in the sound card at the back of the computer.  Windows comes with its own more advanced 
sound recorder in the Entertainment folder, accessed from Accessories in the Start menu. This recorder 
allows you to have full control over the sound quality. It’s worth trying the simple sound recorder in 
PowerPoint first – if the quality of the recorded speech is poor then you can use the Windows sound 
recorder. 
 
Wait! Before you start adding speech or sounds... 
There is one very important change you must make to PowerPoint before you start to add sounds to your 
talking book. This is because PowerPoint stores sounds in two different ways: 
1. If the sound file is small (ie there is not much speech), the complete sound will be stored within the 
PowerPoint pages. 
2.  When the sound file is large (ie contains a lot of speech and/or music), only a link to the sound file is 
stored, and not the sound file itself. This can cause problems transferring the talking book between 
computers. You will get a silent talking book! 
 
What we need to do is alter the settings within PowerPoint to allow larger sound files to be stored within 
the PowerPoint pages, thus avoiding these problems. 
1. Click on Tools, then Options: 
2. In the dialogue box, click on the General tab: 
3. Click in the Link sounds box with files greater than and type in 

50000 (which is the biggest number PowerPoint will accept): This 
will ensure that all sound files smaller than 50,000 Kb (5Mb) are 
included within each of the pages when you save your talking 
book. If it is then used on a different computer, the sounds will 
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play correctly. Five Mb is large enough for all your recorded speech files to be included. 
 
So, now to add the speech... 
1. On any page in your PowerPoint story, click on the Insert menu, click on Movies and Sounds and 

then click on Record Sound: 
 
2. This window will appear: Click on the red record button and speak 

into the microphone. Click on stop at the end and then click in the 
Name box. Delete the words "Recorded Sound" and give the speech 
a meaningful name ("Not me said the parrot" rather than just 
“sound1”, or “speech2”). Then click on OK. Consider recording the 
text on the page. 

 
3. A loudspeaker icon will then appear in the middle of your page: play “not 

me”. This can be positioned wherever you want on the slide using the 
mouse, and resized by clicking on and dragging the corners of the 
frame. Select that you want it to play automatically. 

 
Consider recording: 

• The text that is on the page; the child can hear it read aloud 
• questions about the page 
• part of a repetitive line, so the child finishes it 

 
Adding extra sound effects. Sound effects can also be added to liven up the talking books. These can be 
found from a number of sources, including the internet. Windows comes with a variety of sounds, as do a 
number of other programs. A simple search on your computer will probably reveal a large number of 
sound effects (look for files ending in .wav). You can also buy CDs that contain sound effects - they are 
often included with clipart and picture CDs. 
 

• A1 Sound effects/Cartoon Sounds http://www.a1freesoundeffects.com/cartoon.html  
• Partners in Rhyme http://www.partnersinrhyme.com/wmcstore/WMCshop.cgi  

 
To add extra sounds to your story, click on Insert on the top menu bar, then on Movies and Sounds, and 
then Sound from Clip Organizer or Clip from File. This will open a window from which you can locate the 
sound effect that you require. If you are adding very large sound files (music or video files) to your talking 
book it is very important to make sure that all of the sound files are located in the same folder as the 
talking story that you've created, and that you insert them from this location. So to add large multimedia 
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files to your talking book you need first to copy them into your talking book folder and insert them into 
your talking book. PowerPoint will always look for the sound in the same folder that contains the 
presentation, so this is the best place to put them.  You can also use tracks from an audio CD. 
 

COMPLETING AND SAVING YOUR TALKING BOOK 
Click on the next blank slide. If you are in normal view, this will be in the panel on the left of the screen. If 
you are in slide sorter view, double-click the next blank slide. Add the pictures, symbols and sounds to 
create the second page of the story. Follow the same procedure to make the rest of the pages and check 
them frequently by clicking the run a slideshow icon. 
 
Saving your talking book. You can save your PowerPoint talking books in two different ways: 
1.  If you save your book as a PowerPoint Presentation it will open with all the menus. To use it you either 

click on the run a slideshow icon at the bottom of the screen or press F5. 
2. If you save your book as a PowerPoint Show it will start straight away from your computer when you 

open it. 
 
To save your talking book in either of these formats, choose Save As from the File menu and type a 
name for your book in the File Name box. Then choose either Presentation or PowerPoint Show from the 
Save as type box. Make sure that you are saving the book into the Make A Book folder, then click on 
Save. 
 

ENABLING ACCESS TO YOUR TALKING BOOK 
Your talking story can be accessed by using the keyboard or a switch attached to a switch interface or an 
overlay keyboard. There are also a couple of additional tweaks you can make to your book to give easier 
operation for a switch user. 
Keyboard access. PowerPoint slideshows - i.e. talking books - can work from the keyboard in two basic 
ways called (rather uselessly in our case) Presented by a speaker and Browsed at kiosk. 
• Presented by a speaker. Here the slideshow is controlled by clicking the left mouse button, or by 
pressing the following keys on the keyboard: 
N, Enter, Page Down, Right Arrow, Down Arrow or the Spacebar all trigger the next animation or advance 
to the next slide. 
P, Page Up, Left Arrow, Up Arrow or Backspace all trigger the previous animation or to return to the 
previous slide. 
• Browsed at kiosk (recommended). If you want the mouse to turn a page only when you click on an arrow 
and you do not want the keyboard to operate your talking book then you need to alter the settings to 
Browsed at kiosk. In this setting the slideshow will only work when you click on the forward and 
backwards arrow buttons. We recommend that you set up your shows to be Browsed at kiosk. This 
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ensures that the pages only advance when the arrow keys are clicked and the slideshow doesn’t respond 
to general presses of the mouse button. It does, however, mean that you can no longer operate the 
talking book from the keyboard, but you can still connect a switch or an overlay board. To change the 
access settings, click on the Slide Show menu and choose Set Up Show. 
 
Switch access.  You can connect a single switch to operate a combined speech and page turn button, 
using a switch interface (Don Johnston, RJ Cooper or IntelliKeys). The keyboard switch interface must be 
set to send a mouse click. Once you have positioned the cursor over the next page arrow, the user simply 
has to press the switch to advance to the next page. 
 
Combining a page turn with speech. It is possible to set up your PowerPoint talking book so that a single 
mouse or switch press will not only turn the page but will also speak the text. To do this, the speech and 
page turn need to be combined on one button. Go to the Slide Show menu and click on Slide Transition: 
Click on the Sound box where all your pages’ sounds will be listed. Choose the right sound for the page 
and click on Apply, not Apply To All. Once again the importance of giving the sounds a meaningful name 
really pays dividends here. 
Do this for all the pages. 
 
Adding a time delay to a page turn. Another very useful addition to the single press modification 
described above is to give the forward arrow a timed delay. This prevents users with a tremor making 
rapid switch or mouse presses that would otherwise cause the pages to fly past. 
1.  Click on the forward arrow button on the page with the right mouse button. 
2.  Click on Slide Show, then Custom Animation: Click the Action button box and choose Appear in the 

Entry animation and sound window. Click on the Order & Timing tab, and select Automatically in the 
Start animation box. In the box underneath choose a time delay by using the up/down buttons. We 
would advise using 00:02 seconds. Click on OK. 

 
 
 
 
 
 
 


